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Human Resources Reporting Training Guide 
Visit the Reporting Webpage on the HR Manager Toolkit for HR Reporting Information. 

Human Resources Reporting 
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Reporting at Columbia University - Overview 
Columbia University has two reporting repositories: Accounting and Reporting at Columbia (ARC) and the University 
Data Store (UDS). 

ARC provides real-time access to financial data and the University Data Store (UDS) is the data warehouse repository, 
where data from ARC, PAC/LA, Student, and Historical/Legacy system data is stored. Each component of the University 
Data Store (UDS) contains its own suite of reports. 

UDS is the location of the HR Data Store for HR report data. The reports contain “day old data”, meaning that, running a 
report today displays information as of yesterday. Manager Self-Service Reports and Labor Accounting Reports also use 
HR data but are run directly within PAC. 

Generating Human Resources reports is the focus of this training guide. 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
Types of Reports in each Location and Required Access 

HR Data Store Reports 
They are accessed through myColumbia and any of the below PAC roles are needed (requested via the PAC Security 
Application): 

• Manager Self-Service 
• Manager Reporter 
• Central HR Administration (certain reports) 

 
HR Manager Reports 
HR Manager reports provide detail on employee and job data to help you in managing your day-to-day activities.  

 
Recruitment Reports 
Recruitment reports provide data on job postings, applicants and EOAA information. 
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PAC (People@Columbia) Reports – through the HR System 
PAC is the Columbia University HR system and is the payroll system of record which reflects actual payroll data used for 
reporting and transaction activities. They are accessed through PAC and any of the below PAC roles are needed 
(requested via the PAC Security Application): 

• Manager Self-Service 
• Manager Reporter 
• Accounting Approver 

Note that payroll information is also found in other report suites, such as the Finance Data Store. However, it is 
presented differently specific to the intention of the report and thus may not provide you with accurate information 
needed to perform an HR Payroll transaction, such as the correct earnings code needed for a cost transfer. 

 

Manager Self-Service (MSS) Reports 
Manager Self-Service reports provide individual and department earnings and payroll information. The payroll reports 
available through MSS are extracted from HR data and differ from Finance Reports. Access to MSS Reports is provided to 
the following PAC roles: 

• Manager Self-Service 
• Manager Reporter 

 
Performance Management Reports 
Performance Management Reports provides a report for employees listing information related to the status, dates, 
acknowledgements, and ratings within a fiscal year period. Access to the report is provided to employees holding the 
‘ePerformance Report’ PAC role. 

 
Labor Accounting Reports 
Labor Accounting reports provide detail on Fringe Rates, Funding Setup, Payroll Information, Cost Transfers and 
Suspense Detail in a Department, Employee or Combo Code view. Access to Labor Accounting Reports is provided to the 
following PAC roles: 

• Manager Self-Service 
• Manager Reporter 
• Accounting Approver 

 

Other Reports 
Finance Reports 
Finance reports are accessible through the Financial Data Store and provide various financial detail to assist in day-to-
day activities. For information on financial reporting and access to financial reports, visit the Finance Training Website. 

  

https://www.finance.columbia.edu/content/training
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HR Manager Reports – from the HR Data Store 
HR Manager reports reside in the HR Data Store and are accessed via the myColumbia portal. 

Access the HR Data Store 
1. Log in to myColumbia with your UNI and Password. 

2. Click on the HR Manager tab. 

3. Select the Reports tab. 

4. Select HR Manager Reports. 

 
 
 
 
 
 

The Home Tab (on the BI Launch Pad) 
The landing page is the ‘Home’ tab on the BI Launch Pad. Below is a pictorial and description of the various tabs and tiles 
available. Selecting other tabs across the top such as Favorites or Recent Documents will scroll the page to that section. 

 

https://my.columbia.edu/
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HR Manager Reports Listing 
1. Active Positions 

2. Active Positions and Incumbents 

3. Employee Personal and Job Data - by Bargaining Unit 

4. Employee Personal and Job Data - by Job Function 

5. Employee Personal and Job Data - by Job Function with Columbia University Business Title 

6. Employee Personal and Job Data - by Position Department 

7. Employee Personal Data - by Job Function 

8. Employee Personal Data - by Bargaining Unit 

9. Employee Vacation Accrual 

10. Post-Docs Demographics 

11. Salary Planning – available May – July to users with e-Comp Report Access 

12. Student Officer Appointment Transactions 

13. Terminations 

14. Upcoming/ Past Appointment End Date 

15. Upcoming/Past Visa/Permit Expiration Date 

 

CU Recruitment Manager Reports – HR Manager Use  
1. Applicant List for Job Posting 

2. Equal Opportunity & Affirmative Action Report 

3. Job Posting Dashboard  

4. Job Posting Details 

 

CU Recruitment Reports – Central Administration HR Only 
In addition to the above Recruitment Reports, Central Administrators can run the below reports to check data. 

1. Equal Opportunity & Affirmative Action Report (PAC) 

2. Duplicate Row Checkup and Row Count Checkup 
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How to Generate an HR Manager Report 
The following pages show you how to select prompts (filters) within reports. You run and view all the reports in the 
same way. 
 

Open the HR Report Folder and Select a Report 
Report suites that are available to you per your approved systems access are in the Folders tab. To get started, select 
the Folders tile to view available report suites. 

1. Click the Folders tile.  

2. Expand Public Folders, and then click the word HR. 

3. Click (single click) the desired report under the Title section. 

 

 

 

 

Reports and Prompts (Filters) 
Some reports generate upon selection and others require additional filters, or prompts, to be selected before the output 
displays. 

Reports that Do Not Require Additional Prompt Entry 
Reports without required prompt entries – output generates upon selection. Select the report title from the list. 

Active Positions 
Active Positions and Incumbents 
Employee Vacation Accrual 
Upcoming/Past Appointment End Date 
Upcoming/Past Visa/Permit Expiration Date Report 
 

Example – Employee Vacation Accrual Report. If a report has multiple tabs, they will display along the top. 
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To generate another report, click the back arrow on the top left of the page and then select another report. 

 

 

 

 

 

To navigate to all open documents, click the drop down arrow next to the report listed on the top of the page. A listing 
of current open documents appears. Select the desired document. 

 

 

 

 

 

 

 

 

Reports that Require Additional Prompt Entry 
Because the amount of data is so large, all other reports require filters be selected before the output generates. Filters 
differ depending upon the report. 

 
How to select prompts (filters) 
If a report requires filters be selected to generate the output, a pop up selection screen appears. Items with a check 
mark indicate that a choice was defaulted. Items without a check mark or displaying an “i” icon indicate that a selection 
must be made. Some reports also display the number of Mandatory items needed in the bottom left corner. 

 

 

Check marks appear next to a prompt once selected and when all selections are 
made, the Run button becomes active, and the report can run. 
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Filtering Defaulted Prompts 
Defaulted prompts can be further filtered if if you are looking to limit the amount of data that generates by selecting the 
prompt on the left and then click the Reload load icon (refresh values) on the right. The values appear and you can 
select a specific one from the list (or you can enter the value in the text box). You can filter as many prompts as needed 
and when finished, click Run to generate.  

 

 

 

 

 

 

 

 

Date Prompts 
For reports that require dates, e.g., Start and End, From and To, Appointment Start, Application Effective, Posting 
Effective, or After Title Effective dates, enter the date manually, or select it from the calendar icon on the right side of 
the screen. 

 

 

 

 

 

 

 

When selecting a date from the calendar, navigate to the date, click on 
the day and then click OK on the bottom. Note that there is also a section 
to enter hours if you wanted to see results to that specificity. 
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Department Number/Department Description Prompts 
The default settings, (department start = 0000000) and (department end = 9999999), returns data for all departments 
you have access to view. Depending on the report, this can be the an administrative or the position department. 

Bargaining Unit Prompt 
The default setting is “%” which includes all Bargaining Units.  

Employee Status Prompt 
Three employee statuses (A; L; P) are selected as the default. A = Active; P = Paid Leave; L = Leave of Absence. 

Select Term Prompt 
For reports with a very large amount of data, the information is provided by term. Select the school term and year using 
the format provided. 

 

 

 

 

 

 

 

 

Job Function Prompt 
The default setting is “%” which includes all job functions. 

Job Function Codes and Descriptions: 
• 01 = Officers of Instruction 

• 11 = Officers of Research 

• 21 = Officers of the Libraries 

• 31 = Officers of Administration 

• 41 = Student Officers 

• 51 = Support Staff 

• 61 = Others 
 

Recruitment System 
Settings include TL - TalentLink & R72 RAPS. 

Job Posting Number 
Select the Job Posting Number prompt and then click the Reload Values icon. Then, double-click the desired Posting 
Number or, enter the number in the “Type values here” box and then click the right facing arrow. 
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Saving Filters for Future Report Runs 
To rerun reports using frequently used prompts, click the Save icon after selecting the filters. Then enter a name for the 
saved prompt selection, known as a variant, and click Save. 

  
 
   
 
 
 
 
 
 
 
 
 
To use the created variant, select a report and on the prompt screen, click the Prompts drop-down arrow and select the 
variant you created to load the prompt screen. Then click Run and the already selected prompts that were saved will be 
used to generate the report. 

 
 
 
 
 
 

Navigating Reports 
Once a report is generated, menu sections appear on the top of the page that allow you to view, navigate, and export 
reports. Reference the below for a quick view on how to use these features. 
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Print a Report 
Click on the ellipse icon in the File menu and select Print. Make any changes to the Range or the Layout and select Print. 
The report appears in .pdf format from which you can print.  

The ‘All Reports’ option sends the entire 
document to a pdf which you can then 
print. 

The ‘Current Report’ options allows you 
to select the number of pages that feeds 
to the pdf.  

 

If you export the report into another format such as Excel, you may also print the 
report from that format. See next section. 

 

Saving and Exporting Reports 

The Save As Feature 
Saving a report allows you to rename and place a generated report into your Documents folder on the BI Launchpad. It 
does not export it into a different format on another device. To save a document to your personal folder, follow these 
instructions. 

1. Click the Save icon and select Save As.  

2. Select My Folders and enter a report name in the File Name box and press Save. 

 

 

 

 

 

 

 

 

To access the saved document, navigate back to the Launchpad, click the Home icon, select the Documents tile and then 
select the report from the list.  
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Export a Report 
The export feature is used to save a report in another format on another device. Do not use the “save icon”. 

1. Click the Export icon from the File menu.  

2. Select the desired File Format from the left side and the exporting options on the right. 

3. Select Export and Open the report. 

4. Name the report and select the location on your computer to save it to using the File > Save command for 
software it was exported to (e.g., Excel or PDF). 

 

 

 

 

 

 

 

 

 

Export Options 
After selecting the file format from the left, select the options on the right.  

Excel – Report Option 
Within the Content Tab, select the Reports radio button and keep the “Name of the Report” box checked. The 
document is exported into a formatted Excel report. The Options tab does not require selection. 

Export- Data Option 
Within the Content Tab, select the Data radio button. Check box is greyed out and export creates the document in a .csv 
format. The report title and description do not appear on the top of the document. The Options tab does not require 
selection. 

Export to PDF 
Within the Reports Tab, keep the “Name of the Report” box checked. The document is exported into a .pdf format. The 
Options tab allows you to select the number of pages to include in the pdf. If no selection is made on this tab, the entire 
report is sent to pdf. 

Export to CSV 
This is similar in format to Excel Data exports. Selecting the Reports radio button creates the document in a .csv format 
and has a report title on the top. Selecting the Data radio button creates the document in a .csv format and does not 
have a report title on the top, similar to the Excel Data option. The Options tab does not require selection. 
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More on the Home Page 
Additional navigations and features from the Home Page. 

 

 

 

 

 

 

 

 

 

 

 

Categories 
Categories is an organizational tool that allows you to tag reports into a category that is specific to you and not visible to 
anyone else. It is a way to see and categorize your reports.  

1. From the Report Listing home page, click the ellipse icon at the end of a report to categories. 

2. Select Categories. 

3. Expand Personal Categories drop down and select the Personal Categories check box. Click OK. 

 

Note the scroll bar to the right. Use this to view all category folders. 

To view categorized reports, select the Categories tile from the Home Page and then select the report. 
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Schedule Reports 
Certain users have the access to set a schedule to run reports automatically and have them delivered to your Inbox. 

1. Right click on a report and select Schedule from the menu. Or click the ellipse menu at the end of the row. 

 

 

 

 

 

 

 

 

2. Click Add in the Destinations section and select BI Inbox and click Confirm. Note - Emailing HR Reports is 
restricted to CU eMail domains only. Use caution when sending HR data. 

3. Optional – Edit the report name. Select the radio button for Use Specific Name and then enter your preferred 
report name in the text box. 

 

 

 

 

 

 

 

4. Use the Run Report dropdown menu to select the date(s) to schedule, e.g., Recurring, or Calendar, and enter 
the details for when you want the report to generate. Then click Schedule on the bottom of the page. 

 

 

 

 

 

 

 

  



                                          HR Reporting Training Guide 
 

 

HR Reporting 
 

April 2024 
 Page 15 of 62 

 

5. From the Report Features tab, select the format to deliver the report. E.g., 
Excel – Reports format 

 

 

6. Select Edit Prompt Values to enter any prompts, if required, for the report. 

 

 

 

 

 

 

 

 

 

 

7. Select Schedule on the bottom of the page.You will see the recurring report status on the History page, in the 
Instances section. 

 

 

 

 

 

To view your scheduled reports and their statuses, click the Instances tile from the Home page. You can also run an 
instance, delete it, or reschedule as needed.  
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Task Bar 
On the top right is a task bar where you can search (magnifying glass) and 
receive notifications (horn). Note that the help (?) does not provide results 
as it does not connect to the internet. 

 

BI Inbox 
This is your Inbox. Reports that you scheduled yourself or that someone else scheduled for you, are sent to My Inbox 
and appear on the left side when generated. Select a report and then click View to open. 

 

 

 

 

 

 

 

 

 

 

 

Instances 
Instances is where you access scheduled reports, not the actual report. You can run a report using an existing schedule 
or change the format, details, etc. See the Schedule Reports topic for information on how to schedule reports. 

To see a history of your schedules, select a start and end date using the calendar in the Instance Time section, then click 
GO on the right. 

 

 

 

Recycle Bin 
This is where deleted items are sent. Click the ellipse at the end of a document row and you can restore or permanently 
delete the item. 
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Recent Documents 
Displays recently generated reports in a tile format. Select a tile to 
open the report. 

 

 

Favorites 
This section is initially blank for HR users. To mark a favorite, select that option from the ellipse icon next to a report. 
The section will organize in alphabetical order. 

 
 
 
 
 
Recently Run Documents 
This displays recently run reports in a tile format. Select a tile to view the report. 

 
 
 
 
 
 
Menu Bar 
See below for information on other icons (not previously mentioned) within the menu bar once a report is generated. 
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HR Manager Reports – Description and Output 
Following are the reports contained within the HR Folder and their outputs. 
 
Active Positions Report 
 
Report Description/Use 

This report displays all active University positions that are vacant or filled in administrative departments whose data you 
have access to view. It does not display names of employees who occupy (or occupied) the positions. It is helpful to see 
the positions available in your department or when you need to reclassify a position. Note:  work with your HR Business 
Partner when discussing position changes. 

Report Filters 

This report does not require data selection to generate. 

Report Results 

The report results show: 

• Position Number 
• Position Description 
• Position Status 
• Position Effective Date 
• Job Code 
• Position Department Number 
• Position Department Name 
• Grade 
• Max Head Count 
• Head Count 
• Full/Part Time 
• Standard Hours 
• Work Location 
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Active Positions and Incumbents Report 
 
Report Description/Use 

This report displays all active University positions (vacant or filled) and the names of staff filling any of those positions in 
administrative departments whose data you have access to view. This report is useful to also obtain position numbers 
and it also helps if you need to reclassify a position. Note:  work with your HR Business Partner when discussing position 
changes. 

Report Filters 

This report does not require data selection to generate. 

Report Results 

The report results show: 

• Position Number 
• Position Description 
• Salary Admin Plan Code 
• Job Code 
• Position Department Number 
• Position Department Name 
• Grade 
• Max Head Count 
• Head Count – if 0 then New or EMP is termed. 
• Full/Part Time 
• Standard Hours 
• Work Location 
• Incumbent Employee ID 
• Incumbent Name   
• Manager Position Number 
• Manager Position Description 
• Manager Name 
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Employee Personal and Job Data Reports  
 
Report Description/Use 

There are four versions of this report that displays comprehensive personal and position related data for University 
employees in the selected administrative department(s) and bargaining unit(s) as recorded in PAC and is useful when 
additional personal or job data not available in Manager Self-Service is needed. 

Report Versions  

• Employee Personal and Job Data – by Bargaining Unit 
• Employee Personal and Job Data – by Job Function 
• Employee Personal and Job Data – by Job Function with CU Business Title 
• Employee Personal and Job Data – by Position Department 

Employee Personal and Job Data – by Bargaining Unit - 
Report Filters  

• Admin Department Number (Start) 
• Admin Department Number (End) 
• Value(s) for Bargaining Unit Name (use % for ALL) 
• Employee Status (A; P; L is defaulted)  
• Select Term 

 
Report Results 

• Employee ID, Admin Department Name, Admin Department Number 
• Employee Name, Position Department Name, Position Department Number 
• UNI, Original Hire Date, Service Date, First Tenure Position Date, CU Employee Status 
• Gender, DOB, Ethnic Group Code, Ethnic Group  
• Highest Degree Code, Highest Degree Name, Degree Year, Degree Institution Code 
• Home ZIP, Extract Date, Email, Office Address Line 1, Line 2, Line 3, City, State and Zip Code,  
• Office Phone Number, Term Year, Term Code, Position Number, Position Status Code, Position Status 
• Work Location Code, Work Location, US Citizen, Visa Type Code, Visa Expire Date 
• Tenure Status Code, Tenure Status, Tenure Date 
• Active Positions, Position Entry Date, Appointment End Date 
• Job Code, Job Description, Job Effective Date, Job Function Code, Job Family Code, Job Family  
• ACAD Rank, ACAD Rank 1, ACAD Rank 2, Grade 
• Compensation Rate, Comp Rate End Date, Compensation Frequency Code, Compensation Frequency  
• Weekly Hours, Bargaining Unit Code, Bargaining Unit, Sabbat End Date 
• FT/PT Status, Multiple Positions? 
• Action Type, Action Reason Code, Action Reason, Action Effective Date 
• Position Extract Date 
• Term ID, Position Title, Contract Period Salary, Leave through Date 
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Employee Personal and Job Data – by Job Function - 
Report Filters 

• Admin Department Number (Start)  
• Admin Department Number (End) 
• Job Function (use % for ALL) 
• Employee Status (A; L; P is defaulted) 
• Select Term 

Report Results 

The report results show: 

• Employee ID, Admin Department Name, Admin Department Number, Employee Name 
• Position Department Name, Position Department Number,  
• UNI, Original Hire Date, Service Date 
• First Tenure Position Date, CU Employee Status, Gender, DOB 
• Ethnic Group Code, Ethnic Group 
• Highest Degree Code, Highest Degree Name, Degree Year, Degree Institution 
• Home ZIP, Extract Date, Email 
• Office Address Line 1, Line 2, Line 3, City, State and ZIP Code, Office Phone Number 
• Term Year, Term Code, Position Number, Position Status Code, Position Status 
• Work Location Code, Work Location, US Citizen? Visa Type Code, Visa Expire Date 
• Tenure Status Code, Tenure Status, Tenure Date 
• Active Positions, Position Entry Date, Appointment End Date 
• Job Code, Job Description, Job Effective Date, Job Function Code, Job Family Code, Job Family  
• ACAD Rank, ACAD Rank 1, ACAD Rank 2, Grade 
• Compensation Rate, Comp Rate End Date, Compensation Frequency Code, Compensation Frequency  
• Weekly Hours, Bargaining Unit Code, Bargaining Unit, Sabbat End Date 
• FT/PT Status, Multiple Positions? 
• Action Type, Action Reason Code, Action Reason, Action Effective Date 
• Position Extract Date, Term ID, Position Title 
• Contract Period Salary 
• Leave through Date 

 

Employee Personal and Job Data Report – by Job Function with Columbia University Title 
 
This report is similar to the Employee Personal and Job Data Report – by Job Function described above except that it 
provides the Columbia University Title for the employee. See above for the prompts and output. 
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Employee Personal and Job Data Report – by Position Department 
 
This report provides employee data to departments who have faculty appointed in other departments. It allows you to 
see data for those who have positions in your departments but an admin department that you do not have access to. 

Report Filters 

• Position Department Number (Start) 
• Position Department Number (End) 
• Job Function (% for ALL is defaulted) 
• Employee Status (A; P; L is defaulted) 
• Select Term 

 
Report Results 

• Employee ID, Admin Department Name, Admin Department Number 
• Employee Name, Position Department Name, Position Department Number 
• UNI, Original Hire Date, Service Date, First Tenure Position Date, CU Employment Status 
• Gender, DOB, Ethnic Group Code, Ethnic Group,  
• Highest Degree Code, Highest Degree Name, Degree Year, Degree Institution Code 
• Home ZIP, Extract Date, Email 
• Office Address Line 1, Line 2, Line 3, City, State and ZIP Code, Office Phone Number 
• Term Year, Term Code, Position Number, Position Status Code, Position Status 
• Work Location Code, Work Location  
• US Citizen? Visa Type, Visa Expire Date 
• Tenure Status Code, Tenure Status, Tenure Date 
• Active Positions, Position Entry Date, Appointment End Date 
• Job Code, Job Description, Job Effective Date, Job Function Code, Job Family Code, Job Family 
• ACAD Rank, ACAD Rank 1, ACAD Rank 2,  
• Grade 
• Compensation Rate, Comp Rate End Date, Compensation Frequency Code, Compensation Frequency 
• Weekly Hours, Bargaining Unit Code, Bargaining Unit  
• Sabbat End Date, Full/Part, Multi Pos? Action Type, Action Reason Code, Action Reason, Action Effective Date 
• Position Extract Date, Term ID 
• Position Title, Contract Period Salary 
• Leave through Date 
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Employee Personal Data Reports 
 
Report Description/Use 

There are two versions of this report, one by Job Function, and one by Bargaining Unit, that displays comprehensive 
personal data for University employees in the selected administrative department(s) and job function(s) as recorded in 
PAC and is useful when additional personal data not available in Manager Self-Service is needed. 

Employee Personal Data – by Job Function - Report Filters 

• Admin Department Number (Start) 
• Admin Department Number (End)  
• Job Function (use % for ALL) 
• Employee Status (A; P; L is defaulted) 
• Select Term 

 
 

 
Employee Personal Data – by Job Function - Report Filters 

• Admin Department Number (Start)  
• Admin Department Number (End)  
• Employee Status (A; L; P is defaulted) 
• Bargaining Unit Name (or use % for ALL) 
• Select Term 

 
 
Report Results 

• Employee ID, Employee Record 
• Admin Department Number, Admin Department Name 
• Employee Name, Position Department Number, 
• Position Department Name, Position Title (in the Job Function report version only), 
• Bargaining Unit, UNI 
• Original Hire Date, Seniority Date, First Tenure Position Date, CU Employment Status 
• Gender, DOB, Age, Ethnic Group Code, Ethnic Group 
• Highest Degree Code, Highest Degree Name, Degree Year, Degree Institution Code 
• Home ZIP, Extract Date, Email, Office Address Line 1, Line 2, Line 3, Office City, State and ZIP Code 
• Office Phone Number 
• Tenure Status, Tenure Date (Job Function report version only) 
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Employee Vacation Accrual Report 
 

Report Description/Use 

This report displays the employees to be included in the Year End Vacation Accrual Report exercise. It is a preliminary list 
that should be reviewed for any changes. It is useful to gather employee information in preparation for the Year End 
Vacation Accrual Report exercise. This data is refreshed every June in preparation for this exercise. 

Report Filters 

This report does not require data selection to generate. 

Report Results 

The report results show: 

• Admin Department Number 
• Admin Department Name 
• Job Function Code 
• Last Name 
• First Name 
• Ps Employee ID 

 
 
Post-Docs Demographic Report 

 
Report Description/Use 

This report displays demographic data for all first-time post-docs by department and title effective date. 

Report Filters 

• Department Range (Begin) 
• Department Range (End) 
• After Title Effective Date 

 

Report Results 

The report results show: 

• Name, UNI, 
• Administrative Department Name,  
• Title, Title Effective Date, Year, Month 
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Salary Planning Report - available May - July to users with e-Comp Report Access 
 

Report Description/Use 

This report displays salary data for University employees in the selected administrative department(s). This report is only 
viewable by those who have the Enhanced Manager Self-Service security access with E-Comp/Salary Reporting and is 
only available from May – July. It is useful when preparing for and administering e-Comp for the annual merit increases. 

Report Filters 

• Select a Salary Group ID 

Salary Group ID: 

In this report, the department numbers/job function codes must be selected and moved into the box on the right side. 

Scroll through the listings on the left side and click to select the department/job function code(s). Then click the right 
facing arrow to make the selection. You can also select *ALL* or you can select one or multiple groups. To select 
multiple groups, press down the Ctrl key while selecting groups using the left click of the mouse. 

 

Report Results 

The report results show: 

• Employee ID, Employee Record Number, Name, Administrative Department, Position Department 
• Title, Tenure Status, Grade, E-Comp Status 
• Visa Expiration Date 
• Current Annual Rate, Change Amount, New Annual Rate, Change Percent 
• Group ID, Updated, Submitted 
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Student Officer Appointment Transactions Report 
 

Report Description/Use 

This report displays comprehensive personal and position related data for active student officer new hire and 
reappointment transactions in the selected administrative department(s) and is useful when reviewing the details of 
student officer appointments. 

Report Filters 

• Admin Department Number (Start) 
• Admin Department Number (End) 
• Appointment Start Date 

Report Results 

The report results show: 

• Employee ID, Employee Record, Admin Department Number, Admin Department Name, 
• Employee Name, Position Department Number, Position Department Name, UNI, 
• Original Hire Date, Service Date, CU Employment Status, 
• Gender, DOB, Age, Ethnic Group, 
• Highest Degree Code, Highest Degree Name, Degree Year, Degree Institution Code,  
• Home ZIP, Extract Date, Email 
• Office Addr Line 1, Office Addr Line 2, Office Addr Line 3,  
• Office City, Office State, Office ZIP, Office Phone Number, 
• Work Location Code, Work Location 
• US Citizen, Visa Type Code, Visa Expire Date, 
• Position Entry Date, Appointment Start Date, Appointment End Date, 
• Job Code, Job Description, Job Function Code, Job Family Code, Job Family,  
• ACAD Rank, ACAD Rank 1, ACAD Rank 2, Grade 
• Compensation Rate, Comp-Rate End Date, Compensation Frequency Code, Compensation Frequency 
• Hourly Rate, Weekly Hours, Bargaining Unit Code, Bargaining Unit, 
• Full/Part, Action Effective Date 
• Position Title, Contract Period Salary, CU Business Title 
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Termination Report 
 

Report Description/Use 

This report displays details of terminated employees (through e-Term or paper PAF) based upon the department range 
and position effective date or termination action date. It is useful when confirming dates and information for terminated 
employees. 

Report Filters 

• Department Range (Start)  
• Department Range (End) 
• From Date  
• To Date 

Report Results 

The report results show: 

• Employee ID, Employee Record 
• Employee Name 
• Department ID (Number), Department (Name)  
• Title, Job Code, Grade 
• Action Reason, Effective Termination Date 

Upcoming/Past Appointment End Date Report 
 

Report Description/Use 

This report displays summary data for all employees whose appointment end date occurs within three months from the 
date the report is run. This report also lists employees whose appointment end dates have passed. It is useful when 
preparing and planning to re-appoint someone and during the annual re-appointment process. 

This report does not require data selection to generate. 

Report Results 

The report results show: 

• Position Department (Number), Admin Dept (Number), Admin Dept Name 
• Employee ID, Employee Name, Position Title 
• Appointment End Date 
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Upcoming/Past Visa/Permit Expiration Date Report 
 

Report Description/Use 

This report displays summary data for all employees who have a visa whose expiration date that occurs within three 
months from the date the report is run. This report also lists any employee with an expired visa. It is useful when 
determining if an employee’s visa expiration date approached/is approaching. 

This report does not require data selection to generate. 

Report Results 

The report results show: 

• Position Department Number 
• Position Dept Name 
• Admin Department Number 
• Admin Department Name 
• Employee ID 
• Employee Name 
• Position Title 
• Visa End Date 
• Visa Type 
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Recruitment Reports for Human Resources Managers/Central HR Administrators 
Recruitment reports that contain data regarding applicants and positions are accessible from the CU Recruitment Folder 
and are available to HR Managers and Central HR Administrators. All reports are available to Central HR within the HRIS 
folder and those highlighted are available to all HR Managers within the Manager folder. 

 

 

 

 

 

 

 

Duplicate Row Checkup – in the Watchdog Reports Folder – HRIS Only 
Report Description 

This report displays any duplicate row data in RAPS and TalentLink for Central Admin to make corrections. 

Report Filters 

This report does not require data selection to generate. 

Report Results 

• System CD 
• Application ID 
• Count 

 
 

Row Count Checkup – in the Watchdog Reports Folder – HRIS Only 
Report Description 

This report displays the number of postings, applicants, and other specific count data. 

Report Filters 

This report does not require data selection to generate. 

Report Results 

• System CD 
• Table Name 
• Distinct Count 
• Distinct Count Column 
• Total Count 
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Applicant List for Job Posting 
 

Report Description 

This report provides you with the list of applicants for a specific job posting and is useful for obtaining Columbia work 
history for an applicant and if they have family members working at Columbia or Columbia Affiliates. 

Report Filters 

• Job Posting Number 
• Recruitment System (RAPS or 

TalentLink) 

 

Report Results 

Posting Information: 

• Recruitment System, Post Number, Position Title, Department (Number), Date Posted, Date Closed 

Application Information: 

• Record Number, Application ID, Application Date 
• Posting Hire Position, Posting Hire Position Title 
• Last Name, First Name, Application Status 
• Not Hired Reason, Status Effective Date, 
• Education: HS Diploma, Highest Degree 
• Columbia Work History: Columbia Employee, Laid Off, Laid Off Date 
• Family Members Currently Employed by Columbia University: Family Member 1, Family Member Relationship 1, 

Family Member Dept 1, Family Member 2, Family Member Relationship 2, Family Member Dept 2 
• Family Members Currently Employed by Columbia University Affiliates: Family Member 1, Family Member 2 
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Equal Opportunity & Affirmative Action Report 
 
Report Description 

This report displays details of candidate data related to a position posting, if they were hired, and if not, the reason not 
hired. It is useful for Equal Opportunity and Affirmative Action compliance and reporting. 

 

Report Filters 

• Application Effective Start Date 
• Application Effective End Date 
• Posting Number 
• Department 
• Recruitment System (RAPS or TalentLink) 

 

Report Results 

The report results show: 

• Record Number, Recruitment System 
• Posting Number, Open Date, Position Number, Position Title 
• Job Type, Job Family 
• Department (Number), Department Name  
• Location 
• Last Name, First Name 
• Gender, Gender Not Disclosed, Hispanic/Latino, Hispanic Not Disclosed 
• Am Ind/AK Native, Asian, Black/African American 
• Pacific Islander, White, Race Not Disclosed 
• Application Status, Effective Date, Reason Not Hired 
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Equal Opportunity & Affirmative Action Report (PAC) – HRIS Only 
 
Report Description 

This report displays details for hired employees and is useful for obtaining position, incumbent, and department data. 

Report Filters 

• Transaction Effective Start Date  
• Transaction Effective End Date 
• Action  
• Action Reason 
• Position Number 

Report Results 

The report results show: 

• Record Number, Position Number 
• Job Code, Annual Rt, Job Indicator, Location 
• Union Cd, Library Rank, Job Title, Job Type  
• Dept ID, Dept Name 
• Level 3, Level 3 Name, Level 4, Level 4 Name, Level 6, Level 6 Name (Department Numbers and Names) 
• Empl ID, Last Name, First Name, Gender 
• Am Ind/AK Native, Asian, Black/African American, Hispanic/Latino, Pacific Islander, White,  
• Not Specified, Race Not Provided 
• Hire Date, Grade, FLSA Status, Academic Rank 
• Tenure Status, Current Empl Status, Full/Part Time 
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Job Posting Dashboard 
 
Report Description 

This report displays a dashboard of postings with links to the job posting details and applicant list for the posting and is 
useful for obtaining those details. 

Report Filters 

• Posting Effective Start Date  
• Posting Effective End Date 
• Posting Status  
• Grade 
• Position Number 
• Position Title 
• Department 
• System Source (RAPS or TalentLink) 

Report Results 

The report results show: 

• Record Number, Recruitment System 
• Posting Number (a URL to the Job Posting Details) 
• Applicant List (a URL to the applicant list for the Job Posting) 
• Posting Status, Posting Status Effective Date, Position Title, Department (Number), Post Type 
• Location, Job Type, Bargaining Unit, Incumbent, Hrs Per Wk, Job Family, Grade 

 

Job Posting Details 
 

Report Description 

This report provides you with the details for a specific job posting. 

Report Filters 

• Job Posting Number  
• Recruitment System (RAPS or TalentLink) 

Report Results 

The report result displays the details for the job posting. 
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Legacy – Distinct Parameter Values Sheet – HRIS Only 
 
This is an Excel report that displays the values used within the reports. Reference this sheet for a list of available 
parameter values to enter into the Legacy JAC 58, RAPS58 Report. Categories are Job Type, Position Title, Department, 
Posting Number, Posting Source, and System Source. 
 
Legacy – JAC58, RAPS58 – Job Posting Details – HRIS Only 
 
This report displays position data from the 5.8 versions of JAC and RAPS during the following timeframes. Faculty 
postings – RAPS 5.8: 2008 – 2019 and Admin, Support Staff, and Casuals postings - JAC 5.8: 2008 – 2019. 
 
 
Report Filters 

Required data prompts are below. All other prompts are optional to 
narrow down the results. Click OK on the bottom of the screen.  

• Post Status From Date 
• Post Status To Date 
• For System Source – the field is not required, and you can leave 

it blank to see all system data. Or enter “J%” to get positions in 
JAC or “R%” to get positions in RAPS. 

 
To filter the generated report, export it selecting Microsoft Excel – 
Data Only (XLSX) by changing the file format. This option must be 
selected. 
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PAC Reports – from Manager Self-Service in PAC 
Performance Management, Labor Accounting and MSS reports are run from PAC. 

 

1. Log in to myColumbia with your UNI and Password. 

2. Click on the HR Manager tab. 

3. Select the PAC Icon.   

4. Click the Manager Self Service tile then the 
Manager Reports tile. 

5. Expand the menu to select a report. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

When in PAC, you can also navigate to these report suites using the menu:  Main Menu > Manager Self Service > 
Manager Reports. Expand the menu to select a report.   

 
 
 
 
 
 
 
 
  

https://my.columbia.edu/
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Manager Self-Service Reports and Queries 
Manager Self-Service Reports and Queries are in the Manager Reports folder within Manager Self Service. 

 

 

 

 

 

 

 

 

 

 

 

Manager Self Service Earnings Queries 
Manager Self Service Payroll Queries retrieve earnings and payroll information in a department or employee view. These 
queries return real time data from the Production environment. 

• Department Earnings Register - This report lists regular, overtime, and other earnings for employees in your 
department for ONE designated pay period. 

• Employee Earnings History and Employee Earnings FY History - This report lists regular, overtime and other 
earnings for ONE employee in your department over SEVERAL pay periods (in multiple year view or FY view). 

 
 
Report Use 
These Earnings Reports provide detail on the employee’s earnings as well as the earnings code that indicates the type of 
pay and can be viewed by department or by employee (in history or FY history view). They are helpful when processing 
cost transfers (Labor Accounting users) and you need to determine the exact earn code for the payment. The "- - -" earn 
code is the same as the REG earn code and indicates the earnings were the employee's regular earnings. 

  



                                          HR Reporting Training Guide 
 

 

HR Reporting 
 

April 2024 
 Page 38 of 62 

 

Report Filters 
These reports require entry of additional filters. A message displays instructing you NOT to leave any fields blank on the 
following screen. Click “OK”. You can enter a wildcard or "%" sign to search all items in that field. 

 
Step 1 – Select either the Department Earnings Register or Employee Earning History or Employee Earnings FY History 
link. 
 
Step 2 – Enter data into the fields. When running the report by department, a Pay Period End date is required and when 
running the report by employee, the Employee ID is required. You can further detail the output or to view all available 
data, enter a “%” which is a ‘wildcard’ in PAC and will return all data. 
 

By Department    By Employee (History or FY History) 

 
 
 
 
 
 
 
 
 
 
 
 

• Pay Period End:  Enter or click the magnifying glass to select the pay period date of earnings to view. 
• Pay Frequency: Select the pay period frequency to view.  Options are: % = all paychecks, B = bi-weekly; M = 

monthly; S = semi-monthly or W = weekly. 
• DeptID: Enter the specific department ID or "%" for all departments. 
• Empl ID:  Enter the specific employee ID or type "%" to search for all employees. 
• Name:  Enter the specific employee's name or type "%" to search for all employees. 

 

Step 3 – Click ‘View Results’ 

 

 

 

 

 

 

• Empl ID:  Enter the Employee’s ID number 
(if unknown, can be found on the View 
Employee Personal Information page)  

• Year:  
o Enter the year of earnings to view or 

% to view all available years in the 
PAC database – History report 

o Enter the Fiscal Year of earnings to 
view (% option not applicable) – FY 
History report 
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Manager Self Service Earnings Queries - Report Results 

The results can be exported into an Excel spreadsheet for additional formatting by clicking the link on the top of the 
page. 

 
By Department 
 
 
 
 
 
By Employee 
 
 
 
 
 
 
 

• Dept ID:  The employee's admin department 
• UNI:  The employee's UNI 
• Name:  The employee's name 
• ID (Employee ID):  The unique PAC ID for the employee 
• Co (Company):  The employee will be in CU1 unless s/he is a retiree then s/he will be in REIT 
• Pay Group:  Grouping of employee populations for payroll purposes 
• Frequency:  The compensation frequency for the employee 
• Pay Period End:  The end of the earnings period 
• Check Dt:  The check date for the designated pay period 
• Year:  The earning's year (calendar) – Employee Report Only 
• Off cycle:  Y = Yes; N = No 
• Earn Code:  Earnings Code. The "- - -" earnings code is the same as the REG earnings code and indicates the 

earnings were the employee's regular earnings 
• Description:  Description of the Earnings Code 
• Reg Hours:  Regular Hours for the designated pay period 
• Reg Earns:  Regular Earnings for the designated pay period 
• OT Hours:  Overtime Hours for the designated pay period 
• OT Earns:  Overtime Earnings for the designated pay period 
• Oth Hours:  Other Hours for the designated pay period 
• Oth Earns:  Other Earnings for the designated pay period 
• Addl #:  Indicates the number of additional position numbers an employee has = Department Report only 
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Manager Self Service Payroll Queries 
 

a. Department Payroll Register - This report lists the total gross, total taxes, total deductions, and net pay for 
employees in your department, for ONE designated pay period. 

b. Employee Payroll History and Employee Payroll FY History - This report lists the total gross, total taxes, total 
deductions, and net pay for ONE employee in your department, over SEVERAL pay periods (in multiple year view 
or FY view). 

Report Use 

These Payroll Reports provide payroll detail on the employee’s earnings and can be viewed by department or by 
employee (in history or FY history view). 

Report Filters 

These reports require entry of additional filters. A message displays instructing you NOT to leave any fields blank on the 
following screen. Click “OK”.  You can enter a wildcard or "%" sign to search all items in that field. 

Step 1 - Click either the Department Payroll Register or Employee Payroll History or Employee Payroll FY History link. 

Step 2 – Enter data into the fields. When running the report by department, a Pay Period End date is required and when 
running the report by employee, the Employee ID is required. You can further detail the output or to view all available 
data, enter a “%” which is a ‘wildcard’ in PAC. 

 

By Department    By Employee (History or FY History) 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Pay Period End: Enter or click the magnifying glass to select the pay period date of earnings to view. 
• Pay Frequency: Select the pay period frequency to view.  Options are: % = all paychecks, B = bi-weekly; M = monthly; 

S = semi-monthly or W = weekly 
• DeptID:  Enter the specific department ID or "%" for all departments. 
• Empl ID:  Enter the specific employee ID or type "%" to search for all employees. 
• Name:  Enter the specific employee's name or type "%" to search for all employees. 

 

Step 3 – Click ‘View Results’ 

• Empl ID:  Enter the Employee’s ID 
number (if unknown, can be found on 
the View Employee Personal Information 
page)  

• Year:  
o Enter the year of earnings to view or 

% to view all available years in the 
PAC database – History report 

o Enter the Fiscal Year of earnings to 
view (% option not applicable) – FY 
History report 
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Manager Self Service Payroll Queries Report Results 

The results can be exported into an Excel spreadsheet for additional formatting by clicking the link on the top of the 
page. 

 

By Department 
 

 
 
By Employee 
 

 
 

• Dept ID:  The employee's admin department 
• UNI:  The employee's UNI 
• Name:  The employee's name 
• ID (Employee ID):  The unique PAC ID for the employee 
• Co (Company):  The employee will be in CU1 unless s/he is a retiree then s/he will be in REIT 
• Group:  Grouping of employee populations for payroll purposes – the Pay Group 
• Pay Period End:  The end of the earnings period 
• Check Dt:  The check date for the designated pay period 
• Year:  The earning's year (calendar) – Employee Report Only 
• Off cycle:  Y = Yes; N = No 
• Form ID:  Identifies that the employee will receive their pay by printed check (CUCHK) or by direct deposit 

(CUDDA) 
• Total Gross:  Total gross pay for the designated pay period 
• Total Taxes:  Total taxes taken out for the designated pay period 
• Total Deductions:  Total deduction taken out for the designated pay period 
• Net Pay:  Net pay for the designated pay period 
• DDA Suppressed:  

o Y = Yes - employee does NOT receive a Direct Deposit Advice 
o N = No - employee receives a Direct Deposit Advice 
o BLANK - employee receives a paper check 
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Personnel Action Report 
A Personnel Action Report lists every employee in your department that has had a transaction action date in the current 
month. If the report is run during the first week of a month, only the preceding month's data is available. 

Interpreting the Report 

• Certain transactions, such as TBH, eTerminations or PAF submittals, require the HRPC to run processes to 
complete the transactions. This is the action date for the transaction. 

• In addition to the action date for the transaction, the effective date for that transaction is also displayed. 

• The descriptions of the transactions are displayed using Action and Reason Codes. Action and Reason Codes are 
used in PAC to categorize job and position actions. They indicate the types of changes made to an individual’s 
record. Access the Action and Reason code job aid on the HR Website for more information and code 
definitions.  

Note:  Address changes will not appear on this report. Access the View Employee Personal Information page in MSS to 
view an employee's addresses or the HR Manager Reports on the HR Data Store to retrieve the home zip code and office 
address information for employees in your department(s). See the HR Manager Reports lesson for more information. 

Generate the Report 

Step 1 - Click the Generate a Personnel Action Report link to view the report. No additional data entry is required. The 
report will be created displaying data for departments that you are able to view as per your approved security profile. 

See below for a report example. The results can be exported into Excel by clicking the “Excel Spreadsheet” link at the top 
of the page.   

 

 
 
 

https://humanresources.columbia.edu/content/action-reason-codes
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Performance Management Reports 
Performance Management Reports provides a report for employees listing information related to the status, dates, 
acknowledgements, and ratings within a fiscal year period. Access to the report is provided to employees holding the 
‘ePerformance Report’ PAC role. 
 

Performance Management Reports are in the Performance Management Reports folder within Manager Self Service. 

 

 

 

 

 

 

Status Report for Managers 
a. Managers who hold the “CU eManager” role can access the report. The landing page displays. 
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b. Select the Fiscal Year from the Fiscal Year lookup field. 
 

 
 

c. Select the Document Status from the drop-down menu. 
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d. Select “Include Indirect Reports” if those results are needed. 

 

 
 

e. Select Run Status Report. The report displays the Manager’s direct reports and all indirect reports. 
 

 
 
 
 
 
 
 

 
f. Uncheck “Include Indirect Reports” if you do not want to include those results in the report. 
g. Click on “Run Status Report”. The report only displays the Manager’s direct reports.  
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Status Report for Department Administrators 
a. Department Administrators who hold the “CU ePerformance DA” 

role can access the Status Report for DAs. The report results 
display information for the departments you have access to view. 
 
The landing page displays. 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

b. Create a new Run Control ID.   
i. Click on Add new Value tab. 

ii. Enter a Run Control ID. A new Run Control can be created and retained for different sets of 
Department IDs needed for the report. Once a Run Control has been created, it should always be 
available. 

iii. Follow the steps in the Labor Accounting Reports section on how to run a report using a Run Control 
ID. 
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Labor Accounting Reports and Queries  
Labor Accounting Reports provide details on labor accounting data in PAC and are in are in 
the Manager Reports folder within Manager Self Service. 

 

Each report has slightly different filters, but all will require certain criteria on which to 
base the report, including department number(s) and dates. Each report will be described 
later in this document. Following are the basic steps that apply to generating all reports. 

 

Generate a Labor Accounting Report 
 

Step 1 - Select the report from the menu. 

Step 2 – Create or Reuse a Run Control ID. A Run Control ID is the name you are giving your report. 

 

 

 

 

 

 

 

1. The default search is to Find an Existing Value (Run Control ID). Enter the search box to locate one you have 
used prior or use the dropdowns to view any recent or saved searches. 

2. To create a new Run Control ID, select the “Add New Value” button, enter the name you want to use and click 
“Add”. 

Notes:   

• A Run Control ID cannot contain spaces or special characters. 
• Select a name that will be meaningful to you, so that you can easily find it when you want to reuse it. 
• You can reuse the same run control after you set up a report, and just change the filters, for example the date(s) 

for which you want to run the report. 
• For reports that you are going to run frequently, you may want to set up all the filters once, and then just 

change the date range as required. 

Important! If you are re-using a Run Control ID to generate another report, wait until the first one completes before 
running the next one. 
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Step 3 – Enter, or select, the required data. Parameters differ per report and are detailed in the following pages. Below 
are the steps to follow to generate all reports. 

Department Selection Options: 

Department View – department level grouping selection search and 
selection 

You may want to run a Labor Accounting report for group of similar 
departments rather than for specific level 8 department. To do this: 

a. Enter the first few digits of the department and then a “%” 
sign (e.g., 1610%). 

b. Click the magnifying glass. 

c. This will expand your selection and return all departments 
that begin with 1610. 
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Department View – department node selection – available in certain reports 

You may want to run a Labor Accounting report by node, where available rather than for specific departments. To do 
this: 

a. Select the Department Tree Node radio button. 

b. Key in or use the search feature to enter the 
department node. 

c. This will expand your selection and return all node 
and department values underneath the node you 
entered. 

 

 

 

 

 

 
Step 4 – Select ‘Run’ in the upper-right corner of the screen to view the Process Scheduler Request Screen. Click ‘OK’ to 
run the report or ‘Cancel’, to cancel. Important! Do not change the defaults in the Type and Format columns and do not 
use the drop-down selections to change them. You can select an Excel format after the report generates. 
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Step 5 – Once you click ‘OK’ you return to the report set-up page. Note that the request was given an identifying 
number, the Process Instance. Click on ‘Process Monitor’ to view the status of your report request. 

 
 

 
 
 
 
 

 
Step 6 – Once the Run Status = Success and the Distribution Status = Posted you can view your report. If the status is 
anything else (e.g., queued, pending) you can click Refresh to update the page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Step 7 – View the Report. 

a. Select View Log/Trace from the Actions drop-down 

b. Select the .CSV file which is in Excel format. 
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The following pages will show you the set-up filters for each of the reports. 

 

You run and view all reports in the same way (as illustrated above). 

Fringe Rate Report 
The Fringe Rate Report allows you to view the fringe rate(s) charged, by employee, as of a specific date. 
 
Report Use 
Departments can use the report to determine what fringe rate(s) were used for an employee. Once a report has been 
set up, you can reuse the run-control and just change the date. For example, you may want to run the Fringe Rate 
Report monthly for a group of departments. You can set up the report filters once, and every month select the run 
control and only change the “as of date”. 

 
Report Filters 
1. The ‘As Of’ date 
2. Report View. Select either Department or Employee: 

a. Department – the fringe rate(s) for each employee in the specified department(s) as of the date entered. 
b. Employee – the fringe rate(s) charged for a specific employee as of the date entered. 

3. Enter the department(s) or employee(s) for which you want to run the report. You can search for 
departments/employees using the magnifying glass or you can key in the IDs. You can enter as many departments or 
employees as you want to have on the report. To add extra rows, click on the plus sign. 

4. Follow the steps outlined in the Generate a Labor Accounting Report section to run and view the report. 
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Fringe Rate Report - Report Output 
The report displays the following information. 

• Employee ID:  The unique PAC ID for the employee  
• Empl Rcd:  The record number that is associated with a position/job, e.g., ‘0’ or ‘1’.  Employees can have 

multiple jobs and will thus have multiple Empl Rcd numbers. 
• Last Name:  For the employee. 
• First Name:  For the employee. 
• Department ID:  The employee’s admin department. 
• Earn Code:  Earnings Code. The "- - -" earnings code is the same as the REG earnings code and indicates the 

earnings were the employee's regular earnings  
• Description:  The description of the Earn Code. 
• Combo Code:  The 10-digit system-generated number representing a unique ChartString to where the earnings 

are allocated. 
• Priority:   
• Fringe Code:  The code for the fringe type. 
• Description:  The description of the fringe code. 
• Fringe Rate:  The fringe rate applicable to the individual. 
• ChartField Data:  The ChartField elements (BU/Account/Dept/PCBU/Project/AC/Init/Segment/Site). 
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Funding Setup Report 
The Funding Setup Report provides you with a view of the distribution percentage and combo code(s) an employee’s 
Regular Earnings and Additional Pay are allocated to via Salary Distribution as of a specific timeframe. 

 
Report Use 
Departments can use the report to identify the percentages charged to combo codes used for a particular pay period. It 
will show the percentage of earnings charged to each combo code for an employee between the specified start and end 
dates. The report returns results based on the admin department, not the funding department.   

Once a report has been set up, you can reuse the run-control and just change the date. For example, you may want to 
run the Funding Setup Report monthly for a group of departments. You can set up the report filters once, and every 
month select the run control and only change the start and end dates. 

 
Report Filters 
1. The ‘Start Date’ and ‘End Date’ of the timeframe for the report. 
2. Report View.  Select either Department or Employee: 

a. Department – the funding distribution percentage for each employee in the specified department(s) for the 
fiscal year within the timeframe entered. 

b. Department Tree Node – report can be run at any level of the department tree. Entering a node value will 
display the funding distribution percentage for all employees within that tree node as of the dates 
entered. 

i. Note that you do not have to click the ‘Save’ button on this report to select a department 
node. 

c. Employee – the funding distribution percentage charged for a specific employee for the fiscal year within 
the timeframe entered. 

3. Enter the department(s) or employee(s) for which you want to run the report. You can search for 
departments/employees using the magnifying glass or you can key in the IDs. You can enter as many departments or 
employees as you want to have on the report. To add extra rows, click on the plus sign. 

4. Follow the steps outlined in the Generate a Labor Accounting Report section to run and view the report. 
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Funding Setup Report - Report Output 
The report returns results based on the admin department, not the funding department. 

• Fiscal Year:  The fiscal year in which the funding is allocated. 
• Employee ID:  The unique PAC ID for the employee. 
• Employee Record:  The record number that is associated with a position/job, e.g., ‘0’ or ‘1’.  Employees can have 

multiple jobs and will thus have multiple Employee Record numbers. 
• Name:  The employee’s name. 
• Department ID:  The employee’s admin department. 
• Effective Date:  The date that the allocation is effective as of. 
• Effective Sequence:  The order of items processed on a single effective date. 
• Earn Code:  Earnings Code. The "blank" earnings code field indicates the employee's regular earnings. 
• Budget Sequence:  The sequence of processing of earnings items. 
• Combo Code:  The 10-digit system-generated number representing a unique ChartString. 
• Budget Amount:  The dollar amount budgeted for the item (non-regular earnings only). 
• Distribution Percent:  The percentage of earnings allocated to the combination code. 
• Funding End Date:  The end date for the Salary Profile on the Salary Distribution page in PAC. 
• Source:  J=Job Data; A=Additional Pay. 
• ChartField Data:  The ChartField elements (Business Unit/Account/Department ID (CF)/Business Unit, 

PC/Project/Project Activity/Initiative/Segment/Site). 
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Payroll Actuals Report 
The Payroll Actuals Report allows you to view the combo code(s) employee earnings were charged to, by employee, as 
of a specific date. It shows the actual earnings charges and encumbrances for employees between specified start and 
end dates. 

Report Use 
Departments use the report to identify the payroll actuals and encumbrance balances for the employees in the specified 
departments.   

Once a report has been set up, you can reuse the run-control and just change the date. For example, you may want to 
run the Payroll Actuals Report monthly for a group of departments. You can set up the report filters once, and every 
month select the run control and only change the start and end dates. 

Report Filters 
1. The ‘Start Date’ and ‘End Date’.  The timeframe of the data.   

a. Important! This report can only be run for a 12-month period. E.g., 1/1/22 – 12/31/22 or 7/1/21 = 6/30/22.  
If additional timeframes are needed, run the report again for each timeframe. If you are re-using a Run 
Control ID to generate the next report, wait until the first one is completed before running. 

2. Report View.  Select either Department, Employee or Department Tree Node: 
a. Department – actuals and encumbrances for each employee in the specified department(s) as of the dates 

entered. Select one of “Sort by” options from the drop-down menu for how you want the data sorted. 
i. Admin Dept, Combo Code, Emplid. 

ii. Admin Dept, Emplid, Combo Code. 
b. Employee – the actuals and encumbrances for the specified employee(s) between the dates entered. 
c. Department Tree Node: report can be run at any level of the department tree. Entering a node value will 

display the data for all employees within that tree node as of the dates entered. 
d. Summary – check this box to summarize the output by Earn Code, Combo Code and ChartField. This option 

displays the total charges to each combo codes, per earn 
code. It shows the total charged to a combo code for the 
period entered in the start and end dates. 

3. Enter the department(s) or employee(s) for which you want to run 
the report. You can search for departments/employees using the 
magnifying glass or you can key in the IDs. You can enter as many 
departments or employees as you want to have on the report. To 
add extra rows, click on the plus sign. 

4. Follow the steps outlined in the Generate a Labor Accounting 
Report section to run and view the report. 

  



                                          HR Reporting Training Guide 
 

 

HR Reporting 
 

April 2024 
 Page 56 of 62 

Payroll Actuals Report - Report Output 

• Department ID:  The employee’s admin department. 
• Employee ID:  The unique PAC ID for the employee. 
• UNI:  The employee's UNI. 
• Pay Group:  Grouping of employee populations for payroll purposes. 
• Employee Record:  The record number that is associated with a position/job, e.g., ‘0’ or ‘1’.  Employees can have 

multiple jobs and will thus have multiple Employee Record numbers. 
• Employee Name:   The employee’s name. 
• Position Number:   The identification number for the employee’s position in PAC. 
• Position Description:   The description of the employee’s position. 
• Off cycle:  Y = Yes; N = No. 
• Reversed:  Y = Yes; N = No. 
• Pay End Dt:  The end date of the pay period for the specified earnings. 
• Paycheck Nbr – the corresponding paycheck number will be indicated. 
• Earn Code:  Earnings Code. 
• Combo Code:  The 10-digit system-generated number representing a unique ChartString to where the earnings 

were allocated. 
• Funding Dept:  The department (indicated by department number) that administers the listed combo code. 
• Earnings Amt:  The dollar amount of earnings allocated to the combo code listed for the specified earnings. 
• Transaction ID – will display the Cost Transfer Transaction ID, if applicable.  If the earnings were from a regular 

payroll and did not have a cost transfer made to them a 0 will display.  
• Transaction Type – displays the type of transaction for the specified earnings.  Can be CT = Cost Transfer or PY = 

Payroll. 
• Regular Fringe:  The dollar amount of Fringe expense applied to the specified earnings. 
• Addl Fringe:  The dollar amount of Additional Fringe expense applied to the specified earnings. 
• Fringe Total:  The total dollar amount of Fringe applied to the specified earnings. 
• Encumbrance Earnings Amt:  The dollar amount of earnings encumbered for the specified earnings (through the 

end of the FY). 
• Encumbrance Fringe Amt:  The dollar amount of Fringe expense encumbered for the specified earnings (through 

the end of the FY). 
• Total Earnings:  The total dollar amount of actual and encumbered earnings (through the end of the FY). 
• Total Fringe:  The total dollar amount of fringe expense (through the end of the FY). 
• ChartField Data:  The ChartField elements (Business Unit/Account/Department ID (CF)/Business Unit 

PC/Project/Project Activity/Initiative/Segment/Site). 
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Suspense Detail Report 
The Suspense Detail Report lists all payroll charges in suspense for a department or set of departments as of a specified 
date.  
 
Report Use 
Departments can use the report to identify payroll charges in suspense, and how long a particular charge has been in 
suspense. 

Once a report has been set up, you can reuse the run control and just change the date. For example, you may want to 
run the Suspense Detail Report semi-monthly for a group of departments. You can set up the report filters once, and 
every time select the run control and only change the as of date.  

 
Report Filters 
1. The Pay End Date Range using the ‘From Date’ and ‘To Date’. The timeframe of the data. 
2. Report Type. The report can be run at either the summary or the detail level. 
3. Department Tree Node: report can be run at any level of the department tree. Entering a node value will display the 

suspense for all employees within that tree node as of the dates entered. 
a. Note that you do not have to click the ‘Save’ button on this report to select a department node. 

4. Individual Department: reports can be run for an individual department. Enter the department(s) for which you 
want to run the report. You can search for departments using the magnifying glass or you can key in the department 
ID.  You can enter as many departments as you want to have on the report. To add extra rows, click on the plus sign. 

5. Follow the steps outlined in the Generate a Labor Accounting Report section to run and view the report. 
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Suspense Detail Report - Report Output 

• Pay Begin Dt:  The begin date of the pay period the payroll amount listed is in suspense. 
• Pay End Dt:  The end date of the pay period the payroll amount listed is in suspense. 
• # of Days in Suspense:  The number of days suspense exists based upon the pay end date and the date the 

report was created. 
• Department ID 
• Account Code 
• Combo Code:  The 10-digit system-generated number representing a unique ChartString to where the earnings 

were allocated. 
• Employee UNI:  The employee's UNI. 
• Employee ID:  The unique PAC ID for the employee. 
• Employee Record:  The record number that is associated with a position/job, e.g., ‘0’ or ‘1’.  Employees can have 

multiple jobs and will thus have multiple Employee Record numbers. 
• Pay Group:  Grouping of employee populations for payroll purposes. 
• Job Function:  A numerical indicator identifying the employee group. 
• Function Description:  The description for the job function code. 

o Job Functions:   01 = Officers of Instruction; 11 = Officers of Research; 21 = Officers of the Libraries; 31 = 
Officers of Administration; 41 = Student Officers; 51 = Support Staff; 61 = Others. 

• Last Name:  The employee’s last name. 
• First Name:  The employee’s first name. 
• Earn Code:  Earnings Code. 
• Earnings Amt:  The dollar amount of earnings allocated to the combo code listed for the specified earnings. 
• Fringe Amt:  The dollar amount of Fringe expense for the specified earnings. 
• Earnings and Fringe Total:  The total dollar amount of the Earnings and Fringe for the payroll amount in 

suspense. 
• Check Date:  The end date of the pay period in which the earnings fell into suspense. 
• Funding Dept:  The department (indicated by department number) that administers the listed combo code. 
• ChartField Data:  The ChartField elements (Business Unit/Account/Department ChartField/PC Business Unit 

/Project ID/ Activity Id/Initiative/Segment/Site). 
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Cost Transfer Reports 
The Cost Transfer Reports allow you to view the details of cost transfers, by Admin Department, Department Node, 
Employee ID, Cost Transfer Initiator or Cost Transfer Transaction ID, as of the selected date range. You can also indicate 
if you want to view “All Projects” or “Sponsored Projects Only”.  

 
Report Use 
Departments can use the report to identify payroll charges in suspense, and how long a particular charge has been in 
suspense.   

Once a report has been set up, you can reuse the run control and just change the date. For example, you may want to 
run the Cost Transfer Report monthly for a specified group or project or employee. You can set up the report filters 
once, and every month select the run control and only change the ‘From and To Dates’. 

 
Report Filters 
1. The Date Range entering a ‘From Date’ and ‘To Date’.  The timeframe of the data. 
2. Report Options – select a radio button to indicate the way the report output is displayed and enter the data 

accordingly. 
a. Admin Department – Report can be run for an individual department as of the dates entered. Enter the 

department(s) for which you want to run the report. You can search for departments using the magnifying 
glass or you can key in the department ID. You can enter as many departments as you want to have on the 
report. To add extra rows, click on the plus sign. 

b. Department Tree Node: report can be run at any level of the department tree. Entering a node value will 
display the cost transfer details for all employees within that tree node as of the dates entered.   

c. Project ID – the cost transfer details for each employee for the specified project as of the dates entered. 
d. Cost Transfer Initiator – the cost transfer details for each employee created by the specified Initiator as of 

the dates entered. 
e. Employee ID – the cost transfer details for the specified employee as of the dates entered. 
f. Cost Transfer Transaction ID – the cost transfer details for the specified cost transfer transaction ID as of the 

dates entered. 
3. Projects Option.  Select the radio button to see results for ‘All Projects’ or for ‘Sponsored Projects Only’. 
4. Summary Report Only.  Select the radio button to see results by Combo Code or Project ID. 

a. by Combo Code is the default. The output is summarized by combo codes for the project. 
b. by Project ID.  The output is summarized by Project ID. The total transferred into and out of a project via 

cost transfer is displayed. 
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5. Process Scheduler Request.  Select either: ‘Detail CT Report’ (PDF only) or ‘Summary CT Report’ (Excel Only). 
a. Detail CT Report format is in PDF only. The report provides the CT detail view. Rarely used by 

departments. 
b. Summary CT Report is in Excel only. Allows you to quickly see the movement of total dollars transferred.  

It adds together all line items in a Cost Transfer to display in one row. This summarizes the detail of each 
pay period into one row per Combo Code or by Project ID. Most used by departments. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Follow the steps outlined in the Generate a Labor Accounting Report section to run and view the report. 
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Cost Transfer Report –Report Output 

• CT Transaction ID – will display the Cost Transfer Transaction ID, if applicable.  
• Ern Code:  Earnings Code. 
• Combo Code:  The 10-digit system-generated number representing a unique ChartString to where the earnings 

were allocated. 
• Project ID:  The “UR” or “GG” Project ID number. 
• Requested To %:  The percentage of the cost transfer going to the combo code at time of cost transfer request. 
• Post Processing %:  The actual percentage now allocated to the combo code/project after the cost transfer 

processed. 
• To Earnings:  The dollar amount of the earnings transferred to the combo code/Project listed. 
• From %:  The allocation percentage before the cost transfer processed.  
• From Earnings:  The total dollar allocation before the cost transfer processed. 
• CT Reason Code:  The reason code selected for the cost transfer. 
• CT Reason Code DESCR:  The description of the reason code selected for the cost transfer.  
• CT Status:  The status for the cost transfer.  E.g., ‘Processed’. 
• Min Pay End Dt:  The end date of first pay period indicated in the cost transfer request. 
• Max Pay End Dt:  The end date of last pay period indicated in the cost transfer request. 
• Min Earnings Dt:  The first date of the pay for the earnings in the cost transfer request. 
• Max Earnings Dt:  The last date of the pay for the earnings in the cost transfer request. 
• EMPLID (Employee ID):  The unique PAC ID for the employee. 
• EMPL RCD (Employee Record):  The record number that is associated with a position/job, e.g., ‘0’ or ‘1’.  

Employees can have multiple jobs and will thus have multiple Employee Record numbers. 
• Employee Name:   The employee’s name. 
• Employee UNI:  The employee's UNI. 
• Employee Admin DEPT ID (Department ID):  The employee’s admin department number. 
• Employee Admin Dept DESCR (Department Description):  The employee’s admin department name. 
• Initiator UNI:  The UNI of the person who initiated the Cost Transfer. 
• Initiator Name:   The name of the person who initiated the Cost Transfer. 
• Initiator DEPT ID (Department ID):  The department number of the person who initiated the Cost Transfer. 
• Initiator Dept DESCR (Description):  The department name of the person who initiated the Cost Transfer. 
• CT Created DT:  The date the Cost Transfer was initiated. 
• Final Approver UNI:  The UNI of the last person to approve the Cost Transfer 
• Final Approver Name:  The name of the last person to approve the Cost Transfer 
• Final Approver Dept ID:  The department number of the last person to approve the Cost Transfer.  
• Final Approver Dept DESCR (Department Description):  The department name of the last person to approve the 

Cost Transfer. 
• Final Approved DT:  The date the Cost Transfer was last approved. 
• Justification Comments:  The comments entered on the Cost Transfer 

This report output data reflects the Sponsored Projects section of the cost transfer: 

• New Hire:  Y or N. 
• Rehire:  Y or N. 
• PI Name(s):  The name(s) of the Principal Investigator(s) for the project. 
• Date of Discussion:  The date of discussion entered in this field on the cost transfer request. 
• Document Location:  The text entered in the cost transfer indicating where the documents are kept. 
• Agreement Confirmed:  Y or N. 



                                          HR Reporting Training Guide 
 

 

HR Reporting 
 

April 2024 
 Page 62 of 62 

Pushed Reports and Emails 
 

Pushed Report Data by Email 

In addition to accessing the MSS, HR Manager and Labor Accounting Reports, there is report data that is system 
generated and sent to you via email notification.  

 

Pushed Report Data 

1. Casual 560 Hours Report - this report is sent monthly and includes all casual employees who have worked 420 
hours or more. Reference the Casual Hires FAQs (http://hr.columbia.edu/casual-hires-faqs) on the HR Website 
for more information. 

2. Upcoming Visa/Permit Expiration Date - this report is sent monthly and displays summary data for all 
employees who have a visa whose expiration date occurs within three months from the date the report is run. 
This report also lists any employee with an expired visa. Note that this is also a HR Manager Report and can be 
generated at will. 

3. Suspended Employees - this report is sent weekly and displays employees who have been "hotlined", the 
emergency process to stop someone's pay. Be sure to submit the PAF to HRPC that indicates the official status of 
the employee. 

 

 
 
 

http://hr.columbia.edu/casual-hires-faqs

	Human Resources Reporting
	Reporting at Columbia University - Overview
	Types of Reports in each Location and Required Access
	HR Data Store Reports
	HR Manager Reports
	Recruitment Reports

	PAC (People@Columbia) Reports – through the HR System
	Manager Self-Service (MSS) Reports
	Performance Management Reports
	Labor Accounting Reports

	Other Reports
	Finance Reports



	HR Manager Reports – from the HR Data Store
	Access the HR Data Store
	The Home Tab (on the BI Launch Pad)
	HR Manager Reports Listing
	CU Recruitment Manager Reports – HR Manager Use
	CU Recruitment Reports – Central Administration HR Only


	How to Generate an HR Manager Report
	Open the HR Report Folder and Select a Report
	Reports and Prompts (Filters)
	Reports that Do Not Require Additional Prompt Entry
	Active Positions
	Active Positions and Incumbents
	Employee Vacation Accrual
	Upcoming/Past Appointment End Date
	Upcoming/Past Visa/Permit Expiration Date Report

	Reports that Require Additional Prompt Entry
	How to select prompts (filters)
	Filtering Defaulted Prompts
	Date Prompts
	Department Number/Department Description Prompts
	Bargaining Unit Prompt
	Employee Status Prompt
	Select Term Prompt
	Job Function Prompt
	Job Function Codes and Descriptions:

	Recruitment System
	Job Posting Number


	Saving Filters for Future Report Runs
	Navigating Reports
	Print a Report
	Saving and Exporting Reports
	The Save As Feature
	Export a Report
	Export Options
	Excel – Report Option
	Export- Data Option
	Export to PDF
	Export to CSV


	More on the Home Page
	Categories
	Schedule Reports
	Task Bar
	BI Inbox
	Instances
	Recycle Bin
	Recent Documents
	Favorites
	Recently Run Documents
	Menu Bar


	HR Manager Reports – Description and Output
	Active Positions Report
	Active Positions and Incumbents Report
	Employee Personal and Job Data Reports
	Employee Personal Data Reports
	Employee Vacation Accrual Report
	Post-Docs Demographic Report
	Salary Planning Report - available May - July to users with e-Comp Report Access
	Student Officer Appointment Transactions Report
	Termination Report
	Upcoming/Past Appointment End Date Report
	Upcoming/Past Visa/Permit Expiration Date Report

	Recruitment Reports for Human Resources Managers/Central HR Administrators
	Duplicate Row Checkup – in the Watchdog Reports Folder – HRIS Only
	Row Count Checkup – in the Watchdog Reports Folder – HRIS Only
	Applicant List for Job Posting
	Equal Opportunity & Affirmative Action Report
	Equal Opportunity & Affirmative Action Report (PAC) – HRIS Only
	Job Posting Dashboard
	Job Posting Details
	Legacy – Distinct Parameter Values Sheet – HRIS Only
	Legacy – JAC58, RAPS58 – Job Posting Details – HRIS Only


	PAC Reports – from Manager Self-Service in PAC
	Manager Self-Service Reports and Queries
	Manager Self Service Earnings Queries
	Manager Self Service Payroll Queries
	Personnel Action Report

	Performance Management Reports
	Status Report for Managers
	Status Report for Department Administrators

	Labor Accounting Reports and Queries
	Generate a Labor Accounting Report
	Fringe Rate Report
	Funding Setup Report
	Payroll Actuals Report
	Suspense Detail Report
	Cost Transfer Reports
	Pushed Reports and Emails





